L FileHold

Document & Record Lifecycle Software

RELEASE GUIDE
VERSION 16.2.4



Copyright ©2021 FileHold Systems Inc. All rights reserved.

For further information about this manual or other FileHold Systems products, contact us at
3010 Boundary Road Office #2H, Burnaby, British Columbia, Canada, V5M 4A1, via email
sales@filehold.com, our website http://www.filehold.com, or call 604-734-5653.

FileHold is a trademark of FileHold Systems. All other products are trademarks or registered
trademarks of their respective holders, all rights reserved. Reference to these products is not
intended to imply affiliation with or sponsorship of FileHold Systems.

Proprietary Notice

This document contains confidential and trade secret information, which is proprietary to
FileHold Systems, and is protected by laws pertaining to such materials. This document, the
information in this document, and all rights thereto are the sole and exclusive property of
FileHold Systems, are intended for use by customers and employees of FileHold Systems, and
are not to be copied, used, or disclosed to anyone, in whole or in part, without the express
written permission of FileHold Systems. For authorization to copy this information, please call
FileHold Systems Product Support at 604-734-5653 or email support@filehold.com.



mailto:sales@filehold.com?subject=Library_Adminstration_Guide
http://www.filehold.com/
mailto:support@filehold.com

Table of Contents FileHold 16.2.4

CONTENTS
1. FILEHOLD 16.2 OVERVIEW .......cuctuiieuiieirencenereneenceantenceessnscescsossesssassasssssssssssssassassssssassssssnssssssnssassanssas 1
2. SYSTEM REQUIREMENTS CHANGES FOR FILEHOLD 16.2 ....ccccituiiueiiinnciencrenicrnnccenncsnsessassssssesassssnsesans 1
2.1. APPLICATION SERVER REQUIREMENTS ..vvuuuuneeerererssnnseeeeeeessnnnaseeessssssnnnasesessssssnnsasesesssssnnnsesessssssssnnseseessssnnnnn 1
2.2, DATABASE SERVER .1uuuueiieeeerttuuieeeeesessssnesasesssssssnnsesessssssssnaseessssssssnneseeessssssssseseesssssssnasesessssssssnnseseesssssnnnn 1
2.3. MICROSOFT OFFICE INTEGRATION ....etvvtutuieeeereeruuuneeeeererersssneeeeesssssssneseesssssssnssesessssssssnsesessssssssnnsesessssssnnns 1
2.4, IMICROSOFT SHAREP OINT SUPPORT ...iieieeeieeeeeiesesesesesesesesesesesesesesesesesesesesesesesesesasasasasasasasasesssssesesesesnsesesass 1
3. DOCUMENT REPOSITORY LOCATIONS ENHANCEIMENT.....ccccettetereeerennerenerensernscernssensesenseressessnsesnssens 2
4, AUTO-FILING TEMPLATES = NEW .....cuieiieiriirecteirenctnctantenceecsessencsessessesssassesssssssssssssassssssassenssnssasesnnes 3
5. DOCUMENT ASSEMBLY — ENHANCEIMENTS....ccccttuitttnierenierencernccrnssrsassrsssersssesnssssnsssnssssnssssssssassssnsssans 4
5.1. WATERMARKS ON DOCUMENTS ..uueeeeerurununseeeerrersnnnseeesessssnsnseeessssssssaseeessssssnssasesessssssnsesessssssssnnseseessssnnnnn 4
5.2. WATERMARK MERGE TAG FIELDS .. .eeetvvuuuunseeeereersunnaseeesesssssnnasesesssssssneseesssssssnnsesesessssssnseseesssssssnnseseessssnnnnn 6
5.3. BUILDING DOCUMENTS WITH MERGE TAG FIELDS .uuueverereresesesesesesesesasesesesesesesssesssesasesasasasasasesssssssssssesssssesesass 6
6. FILEHOLD VIEWERS ENHANCEMENT .....ccuittiiitniitencrenerenieranceencrnsesensersssessssesnsessssssnssssnsessssessssssnssans 8
7. DATE AND TIME ENHANCEIVMIENT ....ieuitteieeeiereecreencreneresserasessssssasssenseressessssessssssssssnsssssssssssessssssnsssans 9
8. ADVANCED SEARCH ENHANCEMENT ...cctcuitittictnereeenceeccenceecenncescssssessesssnssssssssssscssssassasssnssasesnssnsenne 10
9. WORKFLOW ENHANCEIMENTS ....cccttuiiitnieieniereerensernsersaserssserassessssssnsssnssssnssssssessssssnssssnsssnssssassssssesas 11
9.1. NEW INTERFACE SCREEN FOR COMPLETING TASKS 11vuuuneeeerrrurunreseeeresssnneseeessssssnnnesessssssssnnnesessssssnnnnnesessssssnnns 11
9.2. NEW MODIFIERS FOR THE SIGNOFF-SHEET MERGE TAG ....cevvutuuuieeeeererunnnieeeessesrsnniesesssessssnnesesssessssnsaesessssssnnns 12
9.3. NEW MERGE TAGS FOR CONVERT TO PDF ..o ceeecere s seseseesse e e s e se s e e s s e s e e e se e e e s e s e s e s e s e s s s e s e s s s e nnan 13
10.MINOR ENHANCEMENTS ....ccuuiituiettietnnereecetenereaseressersssesnssssssssassssasesssssssssssnssssssssassssnsessnsessssssnsesanse 14
10.1. PERFORMANCE IMPROVEMENTS ..eevttuuueeeeesrersnuneseeeessesssneseessssssssnaseessssssssnnesessssssssnesesessssssnsnnsessssssssnsnnsens 14
10.2. DELETING WORKING DOCUMENTS 1tuuuieeeeererttiieeeeererersniieseeessesrsniesesssssssssaesesssssssmeeesessssssmmeeeesssssssnmneeees 14
10.3. DISABLING THE PDF/IMAGE VIEWER ....vveeeveeiiutieeteeeiteeeeseeesseeessesesseeeesesessessssesessesessesesssssssessssessssessssessnsens 15
10.4. DISABLING THE BRAVA VIEWER ...cevvtuueieeeeeeertuiieeeeeeerersnnieseeessssssnnasesssssssssnnesesssssssnneeesessssssnsnnsesessssssnnnsens 16
10.5. DISABLING DOWNLOADING AND VIEWING FOR GROUPS.....uuuuiieiierrrrtiieeeeerrrersieeeeesrsssmneeesessssssmsneeesessssssnineeees 16
10.6. EXTENDED ERROR MESSAGES ..evevtrrerrerererreereeeereeeeeresseeeseseseeseesssesressessesssssssersessersseressssseseeseesesesesesererererens 17
10.7. LOGGING CHANGES TO DROP-DOWN METADATA FIELDS vvuuuueeerrrerunnneseeerrenssnnneseessssssnneseseesssssnnnnsesessssssnnnneees 17
10.8. NEW FILEHOLD DESKTOP APPLICATION HEADER......ccevtvtuuereeererersnneseeesessssnnesessssssssnneesessssssnnnneessesssssnnnnnees 18
10.9. USERS LIST ENHANCEMENT 1evevtreetereeeereeeereeeeeeeeerereressesrerereeesssessesrerssssesssssesererssereseresesssereresesereresesessrererens 18

‘ HOld May 2021



FileHold 16.2.4 Table of Contents

10.10. MULTI-FACTOR AUTHENTICATION WITH DUO ...ccvuniiiiieeeete ettt e et eeete e e et e eeae e eeaneeeseneeennnans 19
LT1.RESOLVED ISSUES .....ccutieuiiinirennirnecrennerenseresserasessssssnssssnserssssssssssnssssssssnssssnsessssessssssnsesnnsssnsessnsesanse 20
T2 KINOWN ISSUES......ccocteuiiienietenerteeteeerenserenseresierasersssssnssssnssressessssssssessssssnsssensersssessssssnssssnsssnsesansenanne 24

May 2021 ‘ HOld



Release Guide FileHold 16.2.4

1. FILEHOLD 16.2.4 OVERVIEW

This document is a high-level description of the new features and enhancements of FileHold
16.2.

2. SYSTEM REQUIREMENTS CHANGES FOR FILEHOLD 16.2.4

The minimum hardware requirements to run FileHold Enterprise or FileHold Express in a
production environment that have been changed for this release are listed below.

For a list of full system requirements, visit https://www.filehold.com/how-to-buy/system-
requirements.

2.1. Application Server Requirements
e Windows 2019 Standard Edition Server is now supported.
¢ Windows 2008 R2 Standard and Enterprise Edition Server is no longer supported.
2.2. Database Server
e SQL Server 2019 Enterprise, Standard, Express is now supported.
e SQL Server 2008 R2 is supported for upgrades only.
2.3. Microsoft Office Integration
e Microsoft Office Professional Microsoft Office Professional 2007 is no longer supported.
e Microsoft Office Professional OneNote 2010 is no longer supported.
2.4. Microsoft SharePoint Support

e Microsoft Office SharePoint Services 2019 is now supported.

e Microsoft Office SharePoint Services 2016 is now supported.

May 2021 < Hold 1
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3. DOCUMENT REPOSITORY LOCATIONS ENHANCEMENT

In previous versions of FileHold, the repository could be split into multiple logical locations to
improve scalability. In this release, a system administrator can additionally define the preferred
location for documents that fit a particular criterion. For example, a cabinet, such as Human
Resources, can have its own repository locations. The library archive can also have separate
repository locations defined. This makes it possible to store the archive documents according
to IT policies and technologies that allow for less expensive storage and backup. The ability to
have multiple repository locations is controlled by a licensing option “Enhanced Repository”.

When configuring document repository locations, groups are configured for their document
preference: default, archive, or cabinet. Within each group is a repository location which sets
the physical storage location. When a file is added to FileHold, the list of preferences is
checked to which group it belongs in. If there is no matching group, the file is placed in the
default group.

O G @oeee =

Drag a column header and drop it here to group by that column

Group status Group name Preference Locations Available space Total files
> [ ] Default repository Default 1 36.87 GB 177
> [ ] Archive Archive 1 189 GB 2
[«] ® HR Cabinet 2 451 GB
Location status Location name Path Allow new files Available space Total files.
o Confidential hr docs GIHRRR No 0B
[ ] More confidential docs H:\MoreHR\ Yes 451 'GB

Files in a particular repository location can be moved to a preferred or default group. Files are
moved as a batch and can be viewed in the Batch Jobs report.

Groups and locations can be deleted; however, repository groups can only be deleted if it
contains no repository locations. A repository location can only be deleted if it is empty; in other
words, there are no files.

For customers with the standard or enhanced repository, the Free space and Warning
thresholds can be set and monitored with new gauge controls.
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Location name Human Resources

Location path F\Secure\HR < -

| Allow new Tiles

99.998 GB

Free space threshold

0 10 20 30 40 50 60 70 80 90 100

Warning threshoeld

10 20 30 40 50 60 70 80 90 100

4. AUTO-FILING TEMPLATES - NEW

Auto-filing is a popular feature for our customers. Auto-filing can take documents from the FDA
Inbox, Manage Imports, Automatic document importation, Print to FileHold, the Microsoft Office
integration, the Add Document Wizard, and WebCap scanner inbox and file them into the
appropriate folders based on predefined values. This feature helps reduce misfiling and
enables faster mass importation of documents.

Auto-filing is a long-time feature in FileHold has required skills for editing XML files or dot net
programming to configure and auto-filing script. In this release, library administrators or higher
roles can apply auto-filing to document schemas by configuring auto-filing templates using a
browser-based management interface. The custom or out-of-the-box auto-filing script are still
available for use.

Configuring auto-filing templates can be configured in a few minutes for simple rules while still
allowing complex expressions using industry standard regular expressions and existing and
new FileHold merge tags. The new template configuration interface includes a built-in tester
and validation tool to simply getting your template just right.
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Manage auto-filing template AP invoices
General Library properties Cabinet Drawer Folder Group Folder Test values

[5Z Cabinet definition ~

Name Accounting always

[5% Drawer definition ~

Name like AP Invoices using [[sys|document-schema]]

[5Z Folder group definition ~

Name like 2020 using [[md|Invoice Date|yyyy]]

52 Folder definition -~

Name like ABC Co using [[md|Vendor]]

a < Previous Next >

5. DOCUMENT ASSEMBLY — ENHANCEMENTS

The assemble documents feature can be used to automatically construct new documents
based on the rules set in the assembly configuration. Some new features have been added to
the assemble document feature.

5.1. Watermarks on documents
Watermarks can now be added to documents via the Assemble Documents feature. Document
assembly requires the FileHold level 2 viewer license.
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July FileHold Systems Inc ABC Co
250-4664 Lougheed Hwy 12345 ABC St.
O Burnaby BC VBC5TH Burnaby BC V4V4v4

This Statement of \ =d pursuant to the Consultant Services Master Agreement
between ABC Co (“Clien stems Inc (“Contractor”), effective August 1, 2017 (the
“Agreement”). This SOW iz s. O and conditions contained in the Agreement

between the parties and is made z term not otherwise defined herein shall have
the meaning specified in the Agreeme. =ny conflict or inconsistency between the

terms of this SOW and the terms of this Ag & = of this SOW shall govern and

prevail-

=X  FileHold Systems Inc \’/
O  250-4664 Lougheed Hwy .

; Burnaby BC V5C5T5 ElLGI:lWO}md
Y

o SOW 12345 for Agreement to Perform Consulting Services to ABC
T o

[0}

E Date Services Performed By: Services Performed For:

[0}

e

©

-—

w

This SOW # 12345 (hereinafter called the “SOW™), effec f 1. 2017, is entered into
by and between Contractor and Client, and is subject to the “ng specified
below. The Exhibit(s) to this SOW, if any, shall be deemed to be = event of any

inconsistencies between the terms of the body of this SOW and the ¢ Zxhibit(s)

hereto, the terms of the body of this SOW shall prevail

Period of Performance

The Services shall commence on August 14, 2017, and shall continue through August 31, 2017-

If the optional workflow module is enabled in the FileHold license, watermark templates can be
created by a library administrator or higher role. These templates can be applied during
document assembly. Up to three templates can be applied per assembly job.

uAcId E Edit m Delete -n Settings v D’ Export v

a column header and drop it here to that column
Name ¢+ Description Active Position
client-external-address Center -
client-hostname: Center
client-internal-address Top
Do not print Use for documents that should not be hard-copy Center
printed.
page of pages Bottom
server-external-address Bottom

Custom ad-hoc watermark templates can also be created on demand in the assemble
document feature. Only one custom watermark template can be applied during document
assembly. Custom watermarks can be combined with watermark templates for a total of three
watermarks per document.
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5.2.

5.3.

Assemble document(s)

Top

Center Do not print

Input Output Assembly options PDF options Actions Summary

Bottom page of pages

Custom watermark G x

Cancel < Previous Next >

Watermark merge tag fields

Merge tags can be used with watermarks to insert information into the assembled PDF
document. Information such as metadata field values, system information, and workflow data

can be inserted as a watermark into the newly generated document.

Watermark tags can be added to watermark templates and custom watermarks.

For example, the watermark tag [[sys|filehold-id]].[[sys|document-version]] produces the

following watermark:

Microsoft Money invoice is used.
check box. Click OK.
3. Goto Tools > FastFind Templates.
4. In the list of FastFind Templates window, c! IN )

press Alt+N.” appears. Select the thi o a nd type Alt+N.

incorrect window was invoked Qlect N \dow and repeat step 5.

1. Open the third party application that you are creating the template for. In this example, a

2. Goto File > Preferences and Settings > FastFind Preferences and select the Enable FastFind

5. The message “Activate the window you £ % mplate to be associated with and

6. A “snapshot” of the application w gD ey astFind Template window. If the

Add FastFind Template

Test Template Edit Add Rui

Name.

Desaription

VendorList  Payrol

View or edit an existing invoice: Accounts Receiva

1 Common tasks

fules: s Change biing or shi
qe bilng or shipping
detas Project: ‘

Customer: | Marvin's Muffins

Name Type

| invoce

| Receive payment for Bllng Address: 3456 Bakery Crescent, Burnaby, BC, VSESI9, CA

L [(agdtern | (Edttem | Defetetem | [(add

e send invoice to ¥ | nem: Filekold Softwate

Building documents with merge tag fields

Documents can be “built” based on new merge tags, such as an agenda. These new merge
tags are available for both document assembly and converting to a PDF in a workflow.

€ FileHold
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e Link inserts a link to another document in FileHold. It displays as a hyperlink in the
assembled document.

e Embed embeds a FileHold document into the source document. The embedded document
can be password protected to protect sensitive or confidential information. The embed
option displays as a paperclip icon in the assembled document.

e Expand expands the contents of a FileHold document in the source document. The
formatting of the assembled document can be taken from the source document, replaced
by the expanded document, or merged. The expanded document must be one of the
supported file types: .doc, .docx, .dot, .docm, .dotx, .dotm, .html, .rtf, .txt. Merge tags can
also be placed within the expanded document.

For example, the following merge tags are placed in a Microsoft Word document:

1. [[link]|2|Link (Default WebClient), Text (This is a linked
document) | Document not available]]
2. [[embed|11l,This is an embedded document and protected with a
password|Document not available]]
3. [[expand|l67|Format (Replace) |Document not available]]
May 2021 Hold 7



FileHold 16.2.4 Release Guide

After document assembly, the resulting document looks like this:

Agenda

Lorem tpsum dolor sit amet, consectetur adipiscing elit. Maecenas ac dui eget lacus lacinia
convallis. Curabitur elementum eget sem vel consectetur. Vestibulum ante ipsum primis m
faucibus orci luctus et ultrices posuere cubilia Curae; Fusce non volutpat ipsum, eu rhoncus
justo. Duis dignissim 1n risus tristique tempus. Quisque tincidunt elit elerfend auctor luctus.
Maecenas non libero dapibus sem feugiat tristique. Praesent tempus neque sit amet tellus
consectetur pretium. Proin sit amet massa faucibus, condimentum lectus sit amet. lacinia
dolor. Cras nisi neque, condimentum vitae placerat eu. fringilla nec lorem. Nunc ultrices
egestas mauris, 1d finibus nunc fimbus sit amet.

Cras 1d lectus sapien. Cras et sollicitudin lacus, dapibus elementum nunc. Suspendisse semper
augue eget tincidunt interdum. Maecenas in eros dolor. Nullam commodo, metus vitae
placerat vehicula, dolor quam convallis velit, at hendrerit ante metus 1d dui. Nullam commodo
velit vitae sem maximus 1aculis. Cras at odio ultrices, commodo massa nec, tmcidunt leo.
Aenean malesuada libero eros, a efficitur nibh maximus et. Vivamus et fingilla diam.
Maecenas in pretinm metus, vitae fermentum velit. Praesent quis urna id est fringilla vulputate
eget quis ligula. Donec non nibh a quam ultrices blandit sed quis lectus.

This is a linked document Linked document

To access this document, enter the passwnrd: e Embedded Wiﬂ'.l password
protection

The following text is using the “expand” merge tag

<beginning of expa text> e Expanded text from another
document

Documents can be “built” based on new merge tags, such as an agenda. These new morge
tags are available for both document assembly and converting to a PDF in a workflow.

* Link inserts a link to another document in FileHold. It displays as a hyperlink in the
assembled document.

* Embed embeds a FileHold document into the source document. The embadded
document can be password protected to protect sensitive or confidential
information. The embed option displays as a paperclip icon in the assembled
document.

* Expand expands the contents of a FileHold document in the source document. The
formatting of the assembled document can be taken from the source document,
replaced by the expanded document, or merged. The expanded document must be
one of the supported file types: .doc, .docx, .dot, .docm, .dotx, .dotm, .html, .rtf,
.txt. Merge tags can also be placed within the expanded document.

<end of expanded text>

6. FILEHOLD VIEWERS ENHANCEMENT

New file formats are now supported by the FileHold viewer level 2:

; € FileHold ey 2021
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e XLSX, ODT, CUR, WSQ, and DXF files.

Not every feature of the supported file formats is supported for viewing. It is recommended that
you test your documents in the viewer in order to determine how your documents are rendered.

7. DATE AND TIME ENHANCEMENT

In previous versions, all times entered or viewed in the system were in the context of the time
zone of the SQL server. In this release, each user can control their time zone. If a user in Berlin
adds a document at 4 pm, a user in New York will see it has been added at 11 am.

In previous versions, most dates were formatted in the US regional style. The only exception
was for metadata fields where administrators had full control. Now, users and administrators
can set the date and time formatting for how the dates and times they see in the system. The
short date, long date, short date and time, and long date and time formats can be configured
globally for users by an administrator, individually on each user account, or end users can
configure in their User preferences. The short date format for May 4, 2020 in Berlin can now be
04/05/2020. The New York office could be 5/4/2020 and the factory in Beijing might see the
same date as 2020-05-04.

Environment Settings

Time Zone (UTC-08:00) Padific Time (US & Canada) ~
Short date format Default e
Default
Long date format M/diyyyy
dd/MM/yyyy
Short time format yyyy-MM-dd

Long time format Default a0

The date display format for a date-type metadata field can be set in the field properties. For
customers who have upgraded from a previous version, these dates will be set to a “custom
date” format with the previous version’s date format entered.

Mame * | Application Date |
DESCI’\DUOH

2
Field Type * [ Date v |

Field Properties

Date Display Format | Custom format hd |
Custom Format | M/ddiyyyy ” Test |
Test Result | |

Initial Value | current date: time v |

| Save ” Cancel |

Other items to note about the date/time enhancement:

May 2021 ’ HOld
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Times in the database are now stored in Coordinated Universal Time (UTC). Custom
reports and software may need to be updated to accommodate this change.

Email naotifications are displayed in the date format of the person being notified.

For Courier transmissions, internal users see their configured time zone and external users
see the system default time zone.

Automatic document importation jobs use the system default time zone.

File properties extraction rules can have date and time extracted according to the local time
(behaviour of previous versions) or using UTC time.

Microsoft Outlook Watched folders, managed imports and watched folders always use local
time.

Upon upgrading to FileHold 16.2, the installer prompts the user to prepare for the time
conversion from local to UTC. The existing SQL Server UTC time offset and how to handle
daylight savings time needs to be set prior to completing the upgrade.

8. ADVANCED SEARCH ENHANCEMENT

New full text search criteria have been added to the Advanced Search screen:

File or metadata — Searches both file contents and metadata for matching search terms.
This search option remains unchanged from previous versions and is the default.

File only — Searches file contents only for matching search terms.

Metadata only — Searches metadata only for matching search terms. This option replaces
the “Search metadata only” check box available in previous versions.

Raw query — A direct search in the dtSearch engine with no adjustments made by FileHold.
Raw dtSearch search terms are required for this option. This option is available only to
system administrators by default.

By default, a natural language query or “Google-like” search is used with the full text search
options above.

Advanced Search Hide Advanced
File or Metadata » onta | E
Full text search il Fiteonly Il Document Versions L) Search Using Historical Metadata Fields &
Document Name Metadata only
Checked Qut Status Raw query optio

@

In order to conduct Boolean-type searches, a new advanced search option “Boolean search”
check box is available. For example:

(banana OR pear OR "apple pie") AND NOT (salad or "ice cream"
finds documents with any of banana, pear or apple pie that do not have salad or ice cream.
The “OR” and “AND NOT” are not case sensitive.

‘ HOld May 2021
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Advanced Search

File or Metadata « |banana or pear or "apple pie" and NOT salad| Search

Boolean search [ Include archive in search | Include all document versions [_| Search using historical metadata values

,® Ssearch Re. s 1-4 of 4

9. WORKFLOW ENHANCEMENTS

Several workflow enhancements have been made for this release.

9.1. New interface screen for completing tasks

When completing task such as reviewing or approving documents or sending documents for
external signature, a new interface can be used for a more clean and friendly experience that
provides more workflow details to the user. For example, task details, activity title, and previous
workflow activities, comments, and actions can be seen on the same screen. Alternatively, the
old interface can still be used.

The new interface is available in the FileHold Desktop Application, Web Client, and Mobile
client.

ay 2021 € FileHold "
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submit approval (7]

Contracis - SOWs_GHI Co SOW_Cct-21-2019

Apiprove 1 docurment{s) with 0 supporting decument{s).
Please approve final contract details.

Add 3 comment to your approval

b

Add a file attschment to your approval

No file chosen

In erder to submit wour approval, rejection or postpane approval of all docurents in this workflow, you must enter your FileHold password.

OO

Due date: 1072212049 1:38 PM
Check out- Not allowed
Password: Required

n Step 3: Approval #2 - Deborah Dixon - 1m

| 508 no issuas

[ step 2: Approval #1 - Basie Fie - 0m
This changas ok O 10 ma.

Step 1: Review final draft - sysadm - Om
I made a fow changes 1o section 2.1, Sae documant.

uAdded initial document - GHI Co Contract - sysadm (1)

The user may be able to choose the interface type, depending on how the administrator has
configured the workflow settings.

Workflow settings (7

Workflow permissions

The following setting determines if one workflow or multiple workflows are initiated when multiple documents are selected.

One Workflow -

The following setting determines what user interface will be available for completing tasks.

mership when initiating workflows or sending Courier transmissions

New only

Classic only stadata when a workflow or Courier approval transmission is active

9.2. New modifiers for the signoff-sheet merge tag

The PDF converter or Assemble document settings allow you to set up merge templates that
can convert documents to a PDF and append information such as the workflow signoff sheet. A
merge template uses “tags” in order to insert FileHold workflow information into the document.

» € FileHold ey 2021
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The [[sys|signoff-sheet]] merge tag adds workflow sign off sheet information to the end of the
document when converted or assembled. The following have been added for horizontal or
vertical table options:

¢ A new modifier “IncludeReviewers” has been added to include review participants.

e A new modifier “Column” that can work with all fields for the table signoff sheet formats.
The modifier allows the user to specify whether a specific field should be included in the
sign off sheet by specifying a true or false value. True causes the field to be included and
false causes the field to be suppressed. Several fields are set true by default including
participant, date, on-behalf-of, document name and workflow name. The fields appear in
the table in the order they are specified in the tag.

e A new “ClearFields” modifier makes all fields false (do not appear).

¢ A new “DateFormat” modifier allows a user to specify the date format for any date/time field
in the signoff sheet. The format must follow standard dot net formatting code.

e Existing columns include participant, date, on-behalf-of, document-name and workflow-
name. This specification adds two new columns to the table: participant-type and comment.
Participant type is “Reviewer” or “Approver”. Note that authors are never included.

e The heading for the participant column changed from “Signer name” to “Participant name”
and the date column heading changed from “Approval date” to “Date”.

For example:

[[sys|signoff-sheet|horizontal,IncludeReviewers,Column (document-
name, false) ,Column (workflow-name,false) ,Column (participant-
type) ,Column (comment) ] ]

Will give the following output:

Participant name | Date On behalf of Participant type Comment

April Ludgate 7/22/2019 Reviewer No comment.

Leslie Knope 7/23/2019 Approver | took your idea
and made it
better.

Ron Swanson 7/24/2019 Approver The less | know
about this, the
better.

For example:

[[sys|signoff-sheet|horizontal,ClearFields|This value is always
inserted]]

Will give the following output:

This value is always inserted

9.3. New merge tags for convert to PDF

New merge tags are available for both document assembly and convert to PDF. The merge
tags are:
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e Link
e Expand
e Embed

See Building documents with merge tag fields for more information.

10. MINOR ENHANCEMENTS

Some minor enhancements have been made to FileHold.

10.1. Performance improvements

e If using “Get a local copy” with a large page size (>1000) in the FDA, the documents are
now downloaded significantly faster.

e The length of time database tables are locked when downloading as zip has been
significantly reduced.

e For developers, a new method has been added to the document finder service called
GetDocumentsWithField that can be used in place of GetDocumentsBySnapshot except
this new method allows you to specify the metadata fields to return instead of relying on the
view. This can help avoid repeated calls to GetDocumentDetails by allowing the developer
to specify the fields to be returned.

e Another improvement for developers allows more than one document version at a time to
be specified for download without using download as zip. A single call to
DocumentManager.PrepareMultipleDocumentsToDownload will return a list of tokens
ready for download.

e FDA inbox and manage imports processing is much faster when documents have
extraordinarily long dropdown menus.

e FDA login speed improved especially over WAN connections and with large numbers of
document schemas.

e Adding documents that include metadata fields with very long dropdown menus is now
faster.

e The FileHold Office Client (FOC) loads faster when there are many schemas in the system
(400+).

10.2. Deleting Working Documents

Working documents are documents that have been checked out or downloaded in the FDA.
The deletion of working documents has been enhanced so that documents can be:

e Automatically deleted without user intervention (new).

e Prompted prior to deletion and given the option to cancel the deletion (present in previous
versions of FileHold).

These options can be controlled by an end user in the User preferences or by a system
administrator in the Client Options > FDA advanced settings.

The working documents folder may be cleaned automatically or the user may be prompted
under certain conditions. This is controlled by the system administrator in the Client Options >
FDA advanced settings.

14
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e When the FDA is minimized to the system tray.

e When the user logs out.

e When the FDA detects it has been disconnected from the FileHold server.
e When the FDA receives a message from Windows to shut down.

Local files that are in use by another process are not deleted and remain in the working
documents and will be processed the next time there is a trigger condition. Local files
associated with electronic documents that are modified will not be deleted. These files should
be managed using manual check in or the working documents synchronization tool. Once the
documents have been checked in / synchronized they will be subject to the automatic deletion

rules.
Client Options 7
e ———
FDA Advanced Settings
Enforce Option name Values Reset default value for all users
Show Welcome Screen at startup [ Enabled v]
Default screen at startup | Blank v |
Maximum simultaneous transfers (1-5) | 1 |
By default delete documents that a user Adds to FileHold [ Disabled v ]
By default delete documents that a user Checks In to FileHold [ Disabled v ]
Prompt for Download Location when a user Makes Copies of Files [ Enabled v ]
Prompt for Download Location when a user Checks Qut Files [ Enabled v ]
Prompt user to remove files when sending them from the Inbox [ Enabled v]
) Automatically clean up user's working documents [ Enabled v ]
() Prompt before automatically cleaning up user's working decuments [ Disabled v]
) When the FDA is minimized to the system tray.
Clean up working documents extended conditions: l7 SR EElEar
") When the FDA detects it has been disconnected from FileHold server
) When the FDA receives a message from Windows to shutdown.

10.3. Disabling the PDF/Image Viewer

By default, the PDF/Image viewer will be disabled upon install or upgrade. The PDF/Image
viewer is being deprecated with this version so it is recommended that users transition to the
FileHold viewer.

Users can re-enable the PDF/Image viewer in their User Preferences > Viewer tab or a system
administration can re-enable in the Client options > FDA advanced settings.

My User Preferences ? X

General Advanced Viewer Contact Information Company Information
Document Viewer Settings
PDF/Image viewer only

0 Enable the old FDA PDF/Image viewer. This viewer is end-of-ife. Transition to the FieHold viewer as soon as
possible.
Orientation of the thumbnai view | Bottom

PDF/Image viewer and Brava viewer

©FilcHold .
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10.4. Disabling the Brava Viewer

System administrators can now disable the Brava viewer so it will no longer be able to open
nor redact a document. The Brava viewer has been deprecated since 2017 so it is
recommended that users transition to the FileHold level 2 viewer instead.

The Brava viewer can be disabled in the Document viewer settings.

$FileHold

My FilcHold

[Edit Brava Office viewer Configuration Settings

User: sysadm | Help

| Logout

Workflow management ‘ Disable the Brava viewer technology. This third party technology is end-of-life. Transition your users to the FileHold viewer as soon as possible

Library management © pisable the Brava viewer technology

System management The following page allows you to control which features of the document viewer are available to users when using the FileHold Desktop Application. Simply select the document viewer features you want to enable for this

Administration reports
L Check All | [ Uncheck All

System configuration

Allow Users To Publish Documents As Adobe PDF Files
Settings
J Allow Users To Publish Documents As Tiff Files
General
J Allow Users To Save View In Jpeg Format
Search

J Allow Users To Print / Print Regions Of Documents

Notifications J Allow Users To Compare Documents

Security J Allow Users To Create ISO Banners / Watermarks For Printing

Document repository locations J Allow Users To Copy Text and Markups In A Document To The Clipboard

Client options ) Allow Users To Copy Regions Of Image Files To The Clipboard

Library configuration

O

[

[

!

[

2 Allow Users To Publish Documents As Csf Files
[

C

[

L Allow Users To View / Create / Edit Markups
!

J Enable Document Redaction

10.5. Disabling downloading and viewing for groups

viewer configuration and click save. Go to the system administration > manage users list to provide users with a license to use the document viewer feature.

Save Cancel

A new group restriction has been added to the group properties: Disable viewing. If enabled,
this restricts users from viewing document in the FileHold viewer. This option is available for

groups with a role of document publisher or lower.

For the disable download and disable printing options, these are now included for groups with
a role of document publisher. In previous versions, only read-only or limited roles had these

options available.

Group Name * [ Human Resources |
Description | |
Role* '@ [ Document Publisher v |
Notes

FileHold Group Members I Display all members in one page

Name
8 Basie Pie

Add Members

Restrictions () pisable emailing documents
¥ Disable sending to Courier
[ Disable download (open, local copy)
) Disable printing
2 Disable viewing
oK || cancel || Apply |

Source
Local

) ©FilcHold
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10.6. Extended error messages

An extended error message is now displayed if an “unexpected error” occurs. In previous
versions, administrators needed to access the event log on the server to view the error. The
“unexpected error” message now includes Details and Copy to Clipboard buttons. This
message can used to assist a user or administrator in solving the issue.

Extended messages appear in the FDA, web client, mobile, and Courier clients.

€ FileHold

Unexpected error

Go to Library

Hide Details | [ Copy to Clipboara

An unexpected error occurred. Please try again or contact your system administratar.

System.Net WebException: The operation has timed out

1161
at FileHold. WebClient.Language. GeiPreferredLanguage() in

at FileHold WebClient BasePage.InitializeCulture() in

at ASP.libraryform_aspx.__BuildControlTree(libraryform_aspx __cirl)
at ASP libraryform_aspx. Frameworklnitialize()

includeStagesAfterAsyncPaoint)
at System Web Ll Page ProcessBeguest)

at System.Web.Services.Protocols.WebClientProtocol. GetWebResponse(WebRequest request)

at System. Web. Services. Protocols. Hitp\WebClientProtocol GetWebResponse(WebRequest request)

at System Web_Services Protocols SoapHttpClientProtocol. Invoke (String methodName, Object]] parameters)

at FileHold WebClient UserPreferencesService. UserPreferences GetUserPreferences() in
c:\Builds\5\FH\FileHold 16.2\src\FileHoldWebClientWeb References\UserPreferencesService\Reference.cs:line

c\Builds\5\FH\FileHold 16 2\src\FileHoldWvebClient\Code'\Language. cs:line 73

C:\Builds\5\FH\FileHold16.2\src\FileHoldWvebClient\Code'\BasePage.cs:line 99

at System Web Ul Page ProcessRequest(Boolean includeStagesBeforeAsyncPoint, Boolean -

© 2019 FileHold Systems Inc.

10.7. Logging changes to drop-down metadata fields

If changes are made to any type of drop-down metadata field, it will now be recorded in the
Library audit log. This includes the type of change: Added, Deleted, or Changed. The following
columns have been added to the log: New lookup by, New retrieve from, Action, Old lookup by,

Old retrieve from, and (number of) Affected documents.

I User name | Basie Pie (13) (7]

4 Description contains | contract manager |
lAFrom| ‘@ T0| ||§

| Apply Fiter || Exportas csv |

Full name User login name Description

Action Date

Library Audit Log

Page size -30 v

Affected documents

sysadm sysadm (1) 1 value(s) for. Contract manager (41) were updated 2019-10-21 13:07:40 -07:00 0
sysadm sysadm (1) Added metadata field: Contract manager (41) 2019-10-17 10:52:23 -07:00
sysadm sysadm (1) 3 value(s) for: Contract manager (41) were updated 2019-10-17 10:52:23 -07:00 0

< FileHold
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Page size |30 v

Action Updated menu option Original menu option
Added April Ludgate

10.8. New FileHold Desktop Application header
New larger minimum, maximum, and close buttons have been added to the FDA header. This
makes it easier for users to access these buttons.
The server URL has also been added to the header. This allows users to quickly see what
FileHold server they are connected to or disconnected from. This is helpful if an organization
has multiple FileHold servers.
FileHold server URL Username Larger minimize, maximize
and close buttons
*  Connected to http://win-55bmeutro2m/FH/FileHold Basie Pie - o X
File View Tools Administration Help y=] .
] —
10.9. Users list enhancement
Information about domain groups has been added to the Users page. This makes it for easier
for system administrators to see what domain group a user is in without having to go into the
user properties.
The User type column now states if the placeholder domain group belongs to a “Domain
group”. The Inherited groups column displays the name of any FileHold groups that have a
domain group assigned to it and the user is a member of.
NOTE: Domain group proxy users are always “disabled”. To see the domain group proxy users
in the Users list, make sure the User status column displays values that are “false” or clear the
filter to see all statuses.
The "QA Unit" domain
group is a member of the
New User type "QA team" FileHold group |
nAddv B Mass edit #Semngsv r_,"Exponv "Domain group" (7]
Drag a column header and drop it here to group by that column
Full name User login name 4 User status User license User type Group(s) Inherited groups FELIWD—
QA Unit Disabled Full Domain group DC2012 QA team . &
Editors, Engineering, Human ulnhented
Basie Pie Basie Enabled Full Local user e & g rou ps"
Deborah Dixon Deborah Enabled Full Local user AECOLRR R 0inES Shows the
Administrators, Mail Room FI|eHO|d
Library Admin libadm Enabled Full Local user Library Administrators groups that
Limited User limitedusert Enabled Limited Local user Limited Users % the domain
QA Cabinet Administrator QA-CabAdmin Enabled Full Domain user DC2012 Cabinet Administrators QAteam group iS
QA Document Publisher Delete QA-DocPubDel Enabled Full Domain user DC2012 QAteam ass|gned to
QA Document Publisher QA-DocumentPublisher Enabled Full Domain user DC2012 QAteam
QA Editor QA-Editor Enabled Full Domain user DC2012 QAteam
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10.10.Multi-factor authentication with Duo

To specify the Duo username, a configuration option is now available in the web.config file in
C:\Program Files\FileHold Systems\Application Server\UserRoleManager. The following key
can be set to "guid", "email”, or "userid". "Guid" is the default username.

<add key="DuoUsername" value="guid" />

May 2021 ’ HOld
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11.RESOLVED ISSUES

ID Title

11319 (FHIT) It is not possible to export an arbitrarily large library tree at one time using
FHIT. The actual number is limited by system performance and the number of
TCP ports configured in the system.

12028 System needs better error-handling messages when the "FH email notifications"
scheduled task(s) fail(s) due to very huge number of related database table
records.

12111 The [[sys|user-id]] tag displays an internal user id instead of the administrator
defined user id.

12138 (Web Client) Senior library administrator should be able to access the
Administration reports > Effective permissions report.

12168 (Courier) Cannot cancel a pending Courier transmission if the one-time license
issued from a now locked license pack.

12183 (Server installer) Failed to handle the name of the FileHold server with more than
15 characters in it during the install process.

12208 (Pre-install HealthChecker) Tool failed to detect the non-installation of ASP.NET
4.5 component in the 1IS server role on a Windows Server 2012 R2.

12652 (Web Client) ADI cannot match a fully qualified drilldown menu field during an
import.

12656 (Web Client) Google Chrome and similar browsers cannot display workflow
notification administration screen when certain custom X-Frame-Options HTTP
header settings are added to IIS.

12660 Dropdown list appears selected, but value displayed is not the value actually
chosen.

12672 Unhandled exceptions found in the server's event viewer which occurred in
various areas of our application.

12680 (Active Directory) Exception thrown during synchronization with certain objects in
the domain.

12722 Missing group membership for the users who belong to the domain group in the
Users list.

12770 The 'Has Markups' field does not appear in the metadata panel of a document if
the 'RedactionModule’ feature was not enabled in the system license.

12776 (HealthChecker) APIKit-related errors appear in the DIl files section of the HTML
report file.

12786 (FDA) Session token is not being refreshed during file upload process.

12832 (Workflow) Wrong value found in the 'Participant responses' field of the workflow
email notification related to an external signature activity.

12867 (FDA) Back to folder button takes user to wrong location under certain conditions.

12868 Missing divider between the public views and the personal views lists found in the

'Select view' drop down field of a folder list.
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ID Title

12873 Column headers do not sort properly when using a custom view associated with a
multi-select dropdown and drill down menu metadata fields.

12895 (FHIT) Existing 'Limited' local user(s) were converted to 'Full' domain user(s) after
the merge users tool process.

12896 (SmartSoft Capture) Certificate errors and other SSL related problems may cause
a license failure without appropriate error details being provided to the user.

12906 (FDA) List of document schemas in the 'Document schema name' field found in
the Document Usage Log is not sorted alphabetically.

12940 Manage imports may map the wrong value for a database dropdown field when
used with a schema lookup.

12952 (FDA) Email address validation with a top-level domain consisting of 5 characters
or more will fail unnecessarily.

13041 (FOC) Itis not possible to select the ‘Delete Local Copy’ option under certain
conditions.

13058 (FHIT) Custom database prefixes with multiple underscore characters cause a
configuration error.

13133 (FOC) Failed to delete local copy of file upon checking-in a new version with the
'‘By default delete docs that a user checks in' option enforced.

13137 (Workflow) Unexpected error occurred upon initiating a ‘custom-named' Workflow
template for a document associated with deleted metadata fields.

13142 (Workflow) Incorrect document format error when file extension uses upper case
letters in “Convert to PDF”.

13163 (Server updater) New “sysadm” email address entered in the upgrade wizard
dialog was not saved during the upgrade process.

13171 (Server installer) Cannot provide a database prefix with value containing
number(s) in it.

13198 (Workflow) Task instructions as received from workflow notification were
truncated to 1000 characters.

13276 (FDA) ‘F5’ does not refresh document status in the 'Documents associated with
<workflow name> workflow'.

13319 (FDA) ‘Limited user’ should not be able to remove page(s) from a document
through PDF/Image viewer.

13323 (Workflow) Adobe external signature authorization token allowed to expire too
early or too late depending on local time zone.

13337 (Courier) Users designated as optional viewers in a transmission with approvers
may receive viewing reminders after the transmission has been approved.

13342 Dropdown menu metadata field database synchronization does not work with the
MySQL ODBC driver.

13348 (SmartSoft Capture) Unexpected error thrown when a user's Capture session in
the FDA has expired.

13473 (FDA) Highlight words in search results — dtSearch generated HTML that cannot

be sent over a web service.
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ID Title

13489 (FDA) System may add an extra & (ampersand) to the name of a document.

13500 (Workflow) Delegated user received an email notification even if the workflow
activity is not active yet.

13509 SSL certificate errors are reported as a simple connection problem when testing a
connection or testing a login on the FDA connection settings dialog.

13514 (Pre-installation Health Checker) There is a false error detected in the FileHold
service account when the domain controller name is not a part of its FDQN.

13562 (Pre-installation Health Checker) Tool may display confusing information in
reference to ASP.NET or .NET Framework version needed installed on the
FileHold server.

13603 (Workflow) System failed to automatically remove a disabled user from a workflow
template.

13613 (FDA) Unexpected error occurred when attempting to add a PDF file associated
with an Extraction rule referencing an invalid date in the PDF.

13614 (FDA) Password-protect feature when assembling doc to PDF is not working
properly.

13640 Search for specific domain group name may not find any results in the Select
Member(s) list when attempting to add a member to a FileHold group.

13676 Wrong value found in the 'Total files in the index' field of the FTS status page after
FTS-indexing of database files such as CSV, Microsoft Access, etc..

13696 Specifying to include CSV files in the full text search index in the
"IncludedFilesList" key in the FullTextSearch's web.config is affected by its
precise positioning in the list.

13702 (Workflow) Insufficient permissions error may occur when attempting to perform
an approval postponed of a workflow to restart from a previous activity when
schema “hidden until approved” option is set.

13703 Search button user interface issues found in Advanced search.

13705 (FDA) System does not properly refresh the Courier recipients list when
attempting to remove any recipient from the list.

14220 When a system exception occurs when attempting to send a license deactivation
warning email notification, the exception is not added to the log.

14237 Wrong effective permissions displayed for a disabled admin user on a
cabinet/folder.

14238 (FDA) Drop-down and drill-down menu fields are not selectable when trying to
copy or move documents to an auto-tagged folder.

14247 Limited users can only log in once to a specific client type.

14267 System does not release 'guaranteed system access' from a disabled user.

14270 (Health Checker) Wrong OS version field value found in the HTML report on
various supported Windows server versions.

14271 (Workflow) Adobe external signature callbacks that fail to execute are not retried.

14311 Failed to publish a new version of a checked-out document using the FileHold

viewer.
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ID Title

14346 (FDA) Failed to select a value in the dropdown menu database field upon tabbing
back from another field.

14359 (Workflow) Unexpected error occurred when you try cancel review/approval task
after completed External signature task when using the “reinstate the source
document version as the current version” option.

14424 (Courier) Unexpected error occurred upon opening a 'View' transmission where
the associated document was deleted.

14453 (FDA) Unexpected error thrown upon opening a file in the FileHold viewer with the
'‘Automatically open in the viewer..." option enabled.

14484 System should not send event notification related to document(s) which have
already been archived

14491 Wrong value extracted from the [ActivityDescription] field when used as a key in a
workflow email notification template

14534 Strange cases of Adobe Sign callbacks could cause the incorrect signing state for
an external signature activity.

14556 List of users not refreshed when repeating a search in change cabinet/folder
owner.

14558 An auto-tagged folder cannot be seen by a user with an administration role when
the user has a reduced role in the folder and is not explicitly included in the
document schema membership.

14569 User activity log “full name starts with” filter can only find exact name matches.

14721 The "Load User Profile" setting of the FHAppPool found in the Advanced Settings
> Process Model in 1IS Manager was reset back from "True" to "False" after
upgrading from a previous FileHold server version to 16.2.

14858 It is not possible to add a UTC offset value in increments of less than one hour.

14908 Upgrading from FileHold 16.1.1 to 16.2 removes the permissions for the local
group "Users" requiring manual intervention following upgrade for Integrated
Windows Authentication to work.

15074 Email extraction rule failed for a small class of emails.

15255 UTC converter incorrectly updates default value for CheckedOutDate in new
records. This causes Server-side OCR to not function for these documents and
may have other side effects.

15331 (Server updater) SQL script error occurred when trying to upgrade from FH15.1 to
16.2 with SQL Server 2008 R2 SP3 as the database version.

15382 (FDA) Prevent from adjusting columns when the server returns deadlock.

15446 (FOC) FileHold Office client not showing on any Office ribbons for O365 64-bit
installs

15648 Fix for Telerik security issue: CVE-2017-11357 and CVE-2019-18935.

15779 (FDA) Unexpected deletion of files listed in working documents in a few
circumstances.

15806 (FDA) Incorrectly naming files created from the Outlook watched folder when the

email subject contained certain reserved characters and or names.
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ID Title

15817 (FDA) High processing overhead related to the working documents database that
worsened as the number of working documents increased and made more
noticeable when the working documents were stored on a slow device. Note that
the progress indicator for uploads may be affected by this change.

15955 (FOC) Exception thrown upon selecting a saved search to choose a file to attach
to a replied/forwarded Outlook email message.

15991 Incorrect file deletion logic in Working Documents Database.

15996 (FDA) Deletes local copy of working document after the second attempt to 'get a
file copy' in a specific scenario.

16003 Incorrect behavior of "old version" documents in Working Documents Database.

12. KNOWN ISSUES

ID Title

8530 (FDA) Word table not correctly formatted in Brava viewer.

9128 (FDA) Part of the today's date is not a link in Document Usage Log.

11371 Document assembly may not work with very large files (> 2GB).

13444 FileHold viewer cannot display embedded documents.

13556 (FDA) Viewer state not correctly restored after workstation sleeps or hibernates for
an extended period.

14353 FileHold viewer annotations may be lost on PDF pages that do not correctly follow
the PDF standard.

14387 (FDA) Pressing Send All from the inbox while files are being transferred in the
background can cause an error message.

14431 (FDA) It may not be possible to see all metadata history when multiple document
panels are open at the same time.

14438 (Updater) User may be prompted to reboot the server more than once during a
server upgrade even though only one reboot is required.

14439 (Updater) Insufficient disk space during an upgrade may display a strange installer
dialog following the insufficient space message.

14466 (FDA) FileHold viewer left panel does not scale correctly when magnification size
changes with CTRL + scroll wheel.

14467 Repeated expansion of the font list for an annotation causes the width of the list to
decrease.

14483 Assemble incorrectly allows selection of an XML file.

14495 Performance of ADI decreases as the number of documents imported for a single
job increases beyond hundreds of thousands.

14520 A one-time workflow activity can be delegated to the user that created the one-time
activity.
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ID Title

14522 The user management page may not work correctly over a proxy where a protocol
downgrade is configured.

14532 (FDA) Workflow task selection from the calendar does not override a previously set
template filter for the My tasks screen.

14539 (FDA) Auto-file button does not work when all metadata field values were filled out
by an extraction rule.

14543 Details of an embedded image may be lost during conversion from Word to PDF.
This is most visible with very fine standalone lines such as a line graph that use a
very narrow width line.

14554 ADI uses the wrong time when no specific value assigned and default for the field is
current date:time.

14555 In an ADI job for a watched folder with fixed metadata values, a dropdown menu
value may revert to its original configuration following an edit to the job.

15309 (FOC) FileHold Office Client not able to add a document opened from Microsoft
Teams.

15368 '‘Export to Excel/CSV' option in the Manage users list failed to export remaining
number of users/objects beyond 100.

15638 Options for the FileHold level 2 viewer are not available when there are no level 2
licenses in the system, but Brava viewer licenses are present.

15656 (FDA) Cannot see the properties of the file in the metadata panel from the History
of document versions from the Show Documents > Version History.

15706 (FDA) 'Send to > Printer' option is missing from a file's context menu option.

15719 Linked documents sent to the Library archive does not appear in the linked files list
of the parent document.

15721 Deleted documents in soft deletion stage still appear in 'My Document Alerts'.

15756 (ADI) Exception thrown when using the 'Document schema default' auto-filing
option for an indirect metadata import job.

15786 Metadata field set as 'Required' and 'Read-only' during schema setup is not being
properly checked for the global read-only constraint setting.

15838 (FTS) Library archive files were not 'FTS-indexed' after initializing/re-indexing
document repository.

16007 (WebClient) Menu items to choose from the drop-down list don't appear after

performing a quick search > In List.
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